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Dbank Quick Start

Do you have a lot of data on your hard disk but have little or no idea which files have what data?  Do you
find it difficult to extract a subset of those data for use with various programs?  Would you like to organize
the data on your hard disk so that they are easy to locate?

Dbank is like a network-ready, tree-structured operating system for time series and cross-sectional data that
runs under Microsoft Windows.  In addition to providing numerous commands for managing, manipulating,
viewing and plotting such data,  Dbank allows you to export the data to many statistical packages and
spreadsheet programs.  Dbank also has built-in multiple regression and ACE modules that provide p-values
if you also have Microsoft Excel on your hard disk.

Dbank provides context-sensitive help.  Also, if the mouse pointer remains over an icon for more than one
second, a short help message will appear at the top of the form.

If you would like to experiment with Dbank, double-click on EXAMPLE.MDB (a data bank) in Dbank’s
file list box.  This will allow you to play with Dbank’s Group, Series, and Tagged Menus.  For starters,
click on the group called FIRST.  Then, from the Group Menu, select Mosaic Time Plot (Alt+G+L).
Dbank will plot all the series in FIRST (and its sub-groups) against time.  To view the data in the series
called BPASPV, double click on the FIRST group in the group list box, and then click on the sub-group
BP.  This will fill the series list box with all the series in the group called [FIRST.BP]. Then click on

BPASPV in the series list box, and from the Series Menu select View (ALT+S+W).

If you have a rectangular dataset saved in an ASCII file (i.e., the data is organized as a matrix, with each
row in the file representing an observation and each column representing all the observations on a
particular series), you can import the dataset into Dbank using the “Add Data...” command in Dbank’s File
Menu.  The “Add Data...” command will read the data and create a data bank with the same name as the
ASCII input file.

Double-click on the new data bank to open it.  You can then manipulate the series in the data bank using
Dbank’s Series and Group Menu.  If you tag any of the series (right-click on any highlighted group(s) or
series name(s) to do so),  Dbank will enable the Tagged Menu (which affects the series in the tagged list
box).  The Tagged list box can collect series from any number of different data banks for processing
together.

If you don’t have a rectangular dataset handy, use EXAMPLE.MAT.  Dbank’s SETUP program copied
EXAMPLE.MAT to the same directory in which you installed Dbank.  To manually input data, simply
click on the input icon.
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DISCLAIMER

Every attempt has been made to free Dbank of bugs and ensure that the program operates as documented.
However, the author disclaims all warranties as to this software, whether expressed or implied, including
without limitation any implied warranties of merchantability, fitness for a particular purpose, functionality
or data integrity or protection.  In particular, in no event shall the author be liable for consequential,
incidental or indirect damages of any kind arising out of the delivery, performance or use of Dbank.

In other (less legalistic) words, use this program as if you wrote it yourself, and be just as understanding if
you run into a bug!

Dbank is Copyright  1993-94, by Sam Ouliaris.  All rights reserved.
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DISTRIBUTION POLICY

Please feel free to (i) upload the Dbank distribution file dbankwin.exe[.zip] to any electronic bulletin
board, (ii) give copies of the distribution file to potential users, so that others can obtain a copy of Dbank
for use in accordance with the license agreement below.

Single-User License: Suggested contribution of  US$25.  A contribution of at least US$25 gives you a
life-time, non-transferable license to use Dbank and future versions thereof.

Institutional/ Non-Network License: A one-time charge of US$25 per machine Dbank
Government/ is installed on.  This license is transferable to another machine.
Corporate:

Per-Server License:  A one-time charge of

minimum of (US$1000, US$15*x)

where x is the number of machines with access to Dbank via the server.  This
license is transferable to another server.

Bundling: If you wish to bundle Dbank with your own product (e.g., data), the charge is
US$15 per unit of original sales (excluding upgrades) of the product incorporating
Dbank.  A non-profit organization need only pay for the first 350 original sales.
The purchaser of the product then has a single-user license as above.

Refund Policy: An individual who reports at least one unknown bug in Dbank, or suggest at least
one original feature that is subsequently implemented in the program, gets his/her
contribution (up to US$25) refunded, or a free single-user license if his/her copy
of Dbank is not licensed.  These persons will be acknowledged explicitly in all
future documentations of Dbank.

Users are entirely responsible for obtaining the latest version of Dbank which will be uploaded at regular
intervals to the Internet site ftp.cica.indiana.edu in the directory /pub/pc/win3/util. If there is demand, new
versions of Dbank (i.e., major upgrades as distinct from uploads to fix bugs) will be released on January 1
and July 1 of each year.

A personal check drawn on a US bank is acceptable.  If you do not have easy access to US funds, please
remit in equivalent local currency.  Please provide an e-mail address if available.

Every licensee will receive a formal license (indicating fees paid) to use Dbank.

If you are reporting a bug, please provide an e-mail address (if available) and the time-stamp of your
version of Dbank which can be read by invoking the “About Dbank...” sub-menu in Dbank’s “Help”
menu.

Any individual owning an account on NUSNET (National University of Singapore NET) has a free, non-
transferable, individual license to use Dbank.  The National University of Singapore has a free campus-
wide NUSNET license to use Dbank.
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Introduction

Dbank is like a network-ready, tree-structured operating system for time series and cross-sectional data
that runs under Microsoft Windows.  The program is modeled after the Microsoft Windows’ File Manager;
however, its fundamental object is a sequence of data rather than a file.  In addition to providing commands
that allow you to create data banks and manipulate the data stored inside them, Dbank allows you to export
the data to a number of statistical packages and spreadsheet programs.

Dbank stores data efficiently and retrieves them very quickly.   The program could be useful to people who
need to organize a lot of data on their hard disk; it might be useful to people who keep the same data in
different formats because they routinely use more than one statistical/spreadsheet package to analyze their
data; and it is likely to be useful in corporations/institutions with large databases that need to be shared
with many users across different programs.

Dbank files are typically organized into groups of series.  A “series” is simply a collection of data.  For
example, data on the Gross National Product of the USA for 1949–1991 (a total of 43 observations) could
be called a series.  A “group” within Dbank is simply a collection of series.  For example, all the series
used in a research paper could be called a group.  Dbank's filing system for groups of series is similiar to
the PC-DOS filing system.  Every data bank has a main group (or “root” directory) which is the point of
growth for all other groups in the data bank.  Every group except the main group has a parent group, and
any group can have one or more sub-groups (or “children”).

Dbank also allows you to build a “temporary” group using its TAG facility.  The TAG facility allows you
to group together many series from any number of data banks and groups.  The tagged group lasts for the
duration of your Dbank session.  The series in the tagged group can then be manipulated as if they were a
permanent group in the data bank.

Dbank has many commands for managing your data.  For example, you can ADD series to the data bank,
EDIT the data stored in a series, MOVE a series from one group to another, and COPY a series to another
series, group or data bank.  Dbank has a command to DELETE a series, one to VIEW the data stored in a
series, and commands to RENAME and PRINT series in the data bank. You can also create new series
from existing series using the MAKE command.

Dbank also helps you manage the data banks you create. There are commands to delete, copy, move,
rename and squeeze data banks.  Dbank also allows you to create read-only data banks, which are
particularly useful in network environments.  In fact, Dbank and all of its data banks can be made to run
directly from a CD-ROM with no prior setup except for the pre-loading of the the DOS utility
SHARE.EXE.  Thus Dbank provides an efficient method of distributing large amounts of data.

Dbank allows you to easily export your data to any one of the following statistical/spreadsheet packages:

  1) AREMOS

  2) TSP

  3) Micro TSP

  4) GAUSS
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  5) LIMDEP

  6) LOTUS, QUATTRO, EXCEL

  7) SAS

  8) SST

  9) MINITAB,

10) RATS

11) BMDP

12) SPSS

Dbank has its own “FREE”, “MATRIX”, and “SERIES” formats.  They are ASCII file formats that can
be read by most programming languages (e.g., FORTRAN).

If you have a copy of Microsoft EXCEL, Dbank can export data directly to an Excel spreadsheet using
Windows’ Dynamic Data Exchange (DDE) facility.

Dbank manages data with ANNUAL, HALF-YEARLY, QUARTERLY, MONTHLY, WEEKLY and
DAILY periodicity.  The DAILY frequency allows you to specify a 5, 6 or 7-day week.  Dbank also has a
NULL frequency that is particularly useful for cross-sectional or undated data.  The program can handle
missing values in the manipulation of series with different periodicities and start/end dates.

Dbank can also convert your data to a lower frequency during the export process (i.e., the process of
copying your data to a file that can be read by another program).  For example, it can convert daily data to
monthly data, and monthly data to annual data.  Furthermore, Dbank can MASK a series during the export
process.  Its masking function allows you to copy an observation in a series depending on the value taken
by another series.  Dbank’s masking feature is very useful for cross-sectional data.
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Installation Instructions

System Requirements

(1) Microsoft Windows 3.1 (or higher) running in enhanced or standard mode with as little as two
megabytes of system memory.  The program has been tested on a 286 machine with two megabytes of memory and a
Hercules monochrome monitor.

(2) A hard disk with at least 7 megabytes of free disk space (Dbank requires 3.5 megabytes of disk space).

Installation Steps

(1) Create a temporary sub-directory on your hard disk (say, C:\TEMP).

(2) Copy the file DBANKWIN.EXE [DBANKWIN.ZIP] to C:\TEMP (which MUST be empty).

(3) [For DBANKWIN.EXE] At the DOS prompt, set the default directory to C:\TEMP.  Then type
DBANKWIN.  This will invoke the DBANKWIN.EXE file that was copied to C:\TEMP in step (2).  DBANKWIN.EXE
is a self extracting file that contains all the files necessary to install Dbank on your computer.  Note: if the

DBANKWIN.EXE file fails to explode into smaller files or the extraction process fails to complete, please slow down

your computer and try again.

[For DBANKWIN.ZIP] Set the default directory to C:\TEMP.  Then type PKUNZIP DBANKWIN.ZIP.
(You will need version 2.04g or later of  PKUNZIP.EXE  to decompress the file.).  DBANKWIN.ZIP is a compressed file
that contains all the files (except, possibly, VBRUN300.DLL) necessary to install Dbank on your computer.

(4) Run Windows.  From the FILE menu of the Program Manager, execute the RUN command (i.e., press
Alt+F+R), and type C:\TEMP\SETUP to execute Dbank’s SETUP program.  You will be prompted for the directory to
which SETUP should install Dbank.  This can be any location on your hard disk EXCEPT the directory to which you
copied DBANKWIN.EXE [DBANKWIN.ZIP].

(5) After SETUP has run, you can delete all the files in C:\TEMP as well as the sub-directory C:\TEMP.

(6) If necessary, edit the DBANK.INI file in the Dbank directory, and change the “StartUpDir=” parameter
to the directory you wish to start with whenever you start Dbank.  By default, “StartUpDir=” is set to the install directory.
Lastly, change “MyUserName=” to your preferred userid (no embedded blanks allowed).  These two steps are normally not
required.

The SETUP program copies EXAMPLE.MDB (a sample data bank) to the same directory that you install Dbank.  It also
copies EXAMPLE.FRE which is the ASCII input file that was used to create EXAMPLE.MDB.  Two other files,
EXAMPLE.SER and EXAMPLE.MAT, provide examples of Dbank’s SERIES and MATRIX input formats (see
‘Reading your data into Dbank’ near the end of this manual).  You can use these files to learn how to create data banks
and export data.

IMPORTANT:  You must load the DOS program SHARE.EXE before invoking Windows to run Dbank.  Insert  the 

following line in your AUTOEXEC.BAT file:

<MS_DOS Directory>\SHARE.EXE /L:500
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DBANK form

Dbank’s startup form is shown above.  The important areas of this form are:

1. File List Box:  lists all the data banks (i.e., files with extension: .MDB) in the default or current
directory.  The data bank you are currently using is indicated by the in the title of Dbank’s startup form
(currently C:\DB\EXAMPLE).

2. Directory List Box: shows the default directory (currently C:\DB) and all of the sub-directories
beneath the default directory.  You can change the default directory using the keyboard or mouse.  The
contents of the file list box are updated whenever you do so.

3. Disk List Box: lists all the drives that your PC can access (including network drives).  The current
drive and its label are shown in the body of the drive list box.  In the above form, the current drive is  C
with a label of  DOS6

4. Group List Box: This list box appears only after you have opened a data bank.  It contains all the
groups in the active data bank. The active group is indicated by the black control bar (currently BP, which
belongs to the group called FIRST) in the group list box. Data bank operations (such as COPY, MOVE,
RENAME,  DELETE, and XDELETE) on a group can be executed from the GROUP menu.  Dbank data
banks possess a hierachical tree structure similiar to the PC-DOS file system.  Double-clicking on a group
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fills the group list box with the names of the groups that belong to that group (and so on to any number of
levels).  Double-clicking on the parent (..FIRST above) moves you up one level in the tree.  Double-
clicking on the main group (1:[ ]  above)  moves you to the main or root group in the data bank.

5. Series List box:  this list box appears after you open a data bank.  It contains all the series in the
default group.  The active series (i.e., the series that will be affected by the next series menu command) is
indicated by the black control bar (currently BPASPV).  Individual series are managed using the SERIES
menu.

6. Tag List Box:  this list box appears only after you tag a series.  You can tag a group of series
using the TAG command in the GROUP menu, or a single series using the TAG command in the SERIES
menu.  You can also tag series/groups using the mouse; simply double-click on the object you wish to tag.
In the above form, some of the series in the “FIRST” group have been tagged.  Note that tagged series have
a superscript “1” appended to their name.  The superscript flags their “tagged” status.

7. File Menu:  contains all the commands Dbank provides to create and manipulate data bank files.
Click on the File menu to invoke one of these commands, or type Alt+F.

8. Group Menu:  contains all the commands Dbank provides to create and manipulate the groups
(and the associated sub-groups) in a data bank.  Click on the group menu to invoke one of these commands,
or type Alt+G.

9. Series Menu:  contains all the commands Dbank provides to create and manipulate the series in
the series list box.  Click on the series menu to invoke one of these commands, or type ALT+S.

10. Tagged Menu:  contains all the commands Dbank provides to manipulate the series in the tagged
list box.  Click on the tagged menu to invoke one of theses commands, or type Alt+T.

11. Filing Cabinet Icon:  when the cabinet is closed, clicking the icon opens the highlighted data bank.
If the cabinet is open, clicking on the icon closes the active data bank.

12. Tree Icon:  click on this icon to invoke Dbank’s “File Tree” command which provides a visual
representation of a data bank's structure.

13. SQL Icon:  click on this icon to invoke Dbank’s “File SQL Query” command which allows your
to execute SQL queries on Dbank data banks.

14. Series Input: click on this icon to invoke Dbank’s “Series Input” command which allows you to
manually input data into a Dbank data bank.

15. Add Data Icon: click on this icon to invoke Dbank’s “Add Data” command which allows you to
add data to a new or existing data bank.
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16. Export Icon:  click on this icon to invoke Dbank’s “Tagged Export” command which allows you
to export the series in the tagged list box to other programs.

17. Scatter Plot:  click on this icon to invoke Dbank’s “Scatter Plot” command which provides a
scatter plot of any two series in the active list box.

18. Time Plot Icon:  click on this icon to invoke Dbank’s “Multiple Time Plot” command which plots
the series in the active list box against time (on a single axis).

19. Mosaic Plot Icon:  click on this icon to invoke Dbank’s “Mosaic Plot Command” which provides
a mosaic plot of all/subset of the series in the active list box.

20. Browse Icon: click on this icon to invoke Dbank’s “Browse” command which invokes Dbank's
Browse module on all/subset of the series in the active list box.

21. View Icon:  click on this icon to invoke Dbank’s “View” command which invokes Dbank's View
module on all/subset of the series in the active list box.

22. Edit Icon:  click on this icon to invoke Dbank’s “Edit” command which invokes Dbank's Series
Editor on all/subset of the series in the active list box.

23. Statistics Icon:  click on this icon to invoke Dbank’s “Summary Statistics” command which
invokes Dbank's Summary Statistics module on all/subset of the series in the active list box.

24. OLS/2SLS/AR(1) Icon:  click on this icon to invoke Dbank’s “Tagged OLS/2SLS/IV” command
which invokes Dbank's regression module.

25. ACE Icon:  click on this icon to invoke Dbank’s “Tagged ACE” command which invokes Dbank's
ACE module.for all/subset of the series in the tagged list box.

26. Excel Icon: click on this icon to invoke Microsoft Excel (if available).

27. Calculator Icon: click on this icon to invoke CALC.EXE (if available).

28. MS-DOS Icon: click on this icon to shell to DOS.

29. Printer Icon:  click on this icon to invoke Dbank’s “Printer Setup” command which allows you to
permanently or temporarily change printer settings.

30. Quick Intro Icon:  click on this icon to get a short statement describing Dbank and its capabilities.
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Dbank Quick Guide

1. How do I start Dbank?

From the Program Manager, double-click on the Dbank 
 

 icon.

If you have Windows 3.1 or greater, you can also start Dbank by typing “Dbank” at the DOS
prompt, provided Windows is not already running and win.com is on the current path.

2. How do I start Dbank with a given data bank opened?

Dbank accepts a single argument (a data bank name) on the command line.  Thus, to automatically
open the data bank EXAMPLE.MDB whenever Dbank is started, type

Dbank C:\DB\EXAMPLE.MDB

3. How do I create an empty data bank?

From the File Menu, choose “Make” (Alt+F+K).

4. How do I open an existing data bank?

From the file list box,  double-click on the data bank you wish to open.  For example, double-
clicking on EXAMPLE.MDB opens the data bank. The distributed version of EXAMPLE.MDB
has two groups: FIRST and SECOND.  These groups will appear in the Group list box when you
open the data bank for the first time.  Note that FIRST has a sub-group called BP.  If you double
click on FIRST, Dbank will set the default group to FIRST and fill the group list box with all the
groups that belong to FIRST (i.e., BP).

5. How do I delete a data bank?

Select the data bank you wish to delete using the mouse; i.e., click on a data bank in the file list
box.  To actually delete the file, click on the File Menu and choose “Delete” (Alt+F+D)

6. Suppose I have data in a file called EXAMPLE.MAT; the data are organized as a matrix (i.e.,

in rows and columns).   How do I read the data into Dbank?

From the File menu, select “Add Data...” (Alt+F+A).  This invokes the File Open dialog box.
Type EXAMPLE.MAT and then click on the OK button of the File Open dialog box.

Provided EXAMPLE.MAT exists, Dbank will create a data bank called EXAMPLE.MDB
(assuming one does not exist already) with a group called EXAMPLE.  The series in
EXAMPLE.MAT will be saved in EXAMPLE and the series in EXAMPLE will be called C1, C2,
C3, .., CN  where N is the number of columns (i.e., series) in EXAMPLE.MAT.
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7. How do I create a group called “THIRD” with a sub-group “GNP”  in EXAMPLE.MDB?

(a) If necessary, open the data bank by double-clicking on EXAMPLE.MDB in the file list
box.

(b) From the Group Menu, select “Make” (Alt+G+M) and then type “THIRD.GNP”.

8. How do I print all the series in the group called “SECOND” in EXAMPLE.MDB?

(a) If necessary, open the data bank by double-clicking on EXAMPLE.MDB in the file list
box.

(b) Click on the group called SECOND in the group list box.

(c) From the Group Menu, select “Print” (Alt+G+P).

9. How do I export ALL the series in the group called “FIRST” and its sub-groups to an EXCEL

spreadsheet using Windows’ Dynamic Data Exchange facility?

(Follow these steps only if you have a copy of EXCEL on your hard disk, and the location of

EXCEL.EXE is on the active DOS Path.)

(a) Open the data bank by double-clicking on EXAMPLE.MDB in the file list box.

(b) Click on the group called “FIRST” in the group list box.

(c) Tag all the series in FIRST by selecting “Tag” from the Group Menu (Alt+G+T).

(d) From the Tagged Menu, select “Export...” (Alt+T+X).  This will invoke Dbank’s EXPORT
form.

(e) From the Format Menu of the EXPORT form, select “DDE to EXCEL” to indicate “Dynamic
Data Exchange” to an Excel spreadsheet.

(f) Indicate the range of observations to export by clicking on the Bounds button of the EXPORT
form.

(g) From the File Menu, declare an output file (i.e., spreadsheet) for the tagged series by selecting
“Open...” (Alt+F+O)

(h) Click on the “Do it!” button of the EXPORT form.  Dbank will start copying the tagged series
to an Excel spreadsheet.
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10. How do I run ACE on a set of series?

(a) The first step is to tag all the series you wish to run ACE on.  To tag all the series in a group,
from the Group Menu, select “Tag” (Alt+G+T) or simply click on the group and then click on the
RIGHT mouse button.  To tag a particular series within a group, from the Series Menu, select
“Tag” (ALT+S+T) or double-click on the series name.

(b) Invoke ACE.  To do so, from the Tagged Menu,  select “ACE”.

11. How do I rename a series in EXAMPLE.MDB?

Select the series you wish to rename using the mouse.  Then invoke the Series Menu, and select
“Rename” (ALT+S+R).

12. How do I rename a group in EXAMPLE.MDB?

Indicate the group you wish to rename by clicking on a particular group in the group list box.
Then invoke the Group Menu, and select “Rename” (Alt+G+R).

13. How do I delete ALL the series in a particular group and its sub-groups; for example, all the

series in the group called “FIRST” and its sub-groups?

Click on the group called FIRST in the group list box.   From the file menu,  select “XDELETE”.
(Alt+G+X).

14. How do I get a mosaic plot of ALL the series in a group and its sub-groups?

The first step is to tag the group.  The easiest way to do this is to use the mouse;  RIGHT-click on
the group name in the group list box.  To plot the series, from the Tagged Menu, select “Mosaic
Time Plot” (Alt+T+T).

15. How do I get a plot of a single series against time?

Click on the series you wish to plot using the mouse.  From the Series Menu, select “Time Plot”
(ALT+S+L).

16. How do I inspect the data in a particular series?

Click on the series you wish to inspect.  From the Series Menu, select “View” (ALT+S+V).

17. How do I edit the data in a particular series?

Click on the series you wish to edit.  From the Edit Menu, select “Edit” (ALT+S+E).
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18. How do I compute the growth rate of a series using Dbank’s Series Make facility?

Suppose you need to compute the growth rate of BPB, a series in the group called FIRST, and you
want to store the result in a series called GBPB in a group called GROWTH.USA

(a) Double click on the group called FIRST and then click on the sub-group called BP.

(b) From the Series Menu, select “Make” and enter:

[growth.usa]gbpb = ((bpb-lag(bpb))/lag(bpb))*100.

Dbank will create a series called GBPB in the group “GROWTH.USA” containing the (quarterly)
growth rate of BPB.

19. Is it possible to select more than one item in the group, series, and tagged list boxes?

The group, series and tagged list boxes allow you to select multiple items.  To do so using the
mouse, hold the left mouse button down and drag the cursor over the items you wish to select.
Shift+click or Shift+arrow key extends the selection from the previously selected item to the
current item. Ctrl+click selects or de-selects an item in the list.  Ctrl+drag can be used to select
disjoint clusters of items.
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File Menu

The File Menu (shown above) provides basic file management commands for Dbank data banks.  You can
invoke the File menu using the mouse (simply click on the File menu) or via the keyboard (press Alt+F).

The file list box allows you to select more than one data bank.  To select a single data bank, click on the
data bank using the mouse. Shift+click or Shift+arrow key extends the selection from the previously
selected item to the current item.  Ctrl+click selects or de-selects an item in the list.

File Open [CTRL+O, ENTER, SPACEBAR]

This command opens a data bank.  All the data banks in the current directory (i.e., files with extension
.MDB) are shown in the file list box.  Select the data bank you wish to open using the keyboard or the
mouse.  If the data bank is opened successfully, Dbank displays the group and series list boxes. The group
list box contains all the groups in the data bank, and the series list box has all the series in the active group.

Mouse Shortcut: Double-click on the data bank you wish to open.
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File Close [CTRL+L]

Closes the active data bank and removes the group, series and tagged list boxes.

Mouse Shortcut:  Select the data bank to close, and then click on the RIGHT mouse button.

File Query

Finds all the series in the selected data banks that satisfy your query.  The matched series are displayed in
Dbank’s BROWSE form, which allows you to COPY, DELETE, TAG, UNTAG, RENAME, EDIT,
PLOT, and VIEW the series.  You can construct queries on the series titles ([Title]), the series names
([Name]), the series “memo” [Description], the frequency of the series ([Frequency]), and the “long-name”
of the series ([Long Name]).

Any of these items can be combined into a single SQL query using the File Query SQL statement
command.  For example, the SQL statement

[Title] LIKE "*BALANCE*" and [Frequency] = "Q"

finds all the quarterly series in the selected data banks with the string "BALANCE" in their title.

File Copy [CTRL+C]

Creates a copy of a data bank.

File Delete [CTRL+D]

Deletes a data bank. The file must not be write-protected.

File Dump [CTRL+P]

Dumps the contents of a data bank (i.e., all the series and data) to an ASCII file structured in Dbank's
FREE format.

File Tree [CTRL+E]

Provides a visual outline of the a data bank's group/tree-structure.

File Make [CTRL+K]
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Creates a new data bank.

File Move [CTRL+V]

Moves/renames a data bank.  You can use this command to rename or move a data bank to another hard
disk.

File Rename [CTRL+R]

Renames/moves a data bank.  You can use this command to move a data bank to another location on the
same hard disk or to another hard disk.

File Repair [CTRL+I]

Repairs a data bank.  This command enables you to recover from accidents that may have corrupted the
data bank file—e.g., a power-out,  a UAE, etc.

File Upgrade [CTRL+U]

Upgrades an exisiting data bank to the latest Dbank format.  This command does nothing if the data bank's
structure is current.

File Squeeze [CTRL+Z]

Removes the unused or dead space in a data bank that is created whenever you delete a series from the data
bank. The squeeze command creates a new data bank which is the same as the original data bank but
without the unused space.

SUGGESTION: Though much care has gone into ensuring that the squeeze command is free of bugs,

for added protection, you may wish to backup your data bank BEFORE invoking this command.  You

can make copies of data banks using the Copy command in the File Menu.

File Make Read-Only [CTRL+Y]

This command protects a data bank against writes without restricting read access.  Dbank commands that
can change the contents of the file are automatically disabled whenever you access a write-protected  data
bank. This command is particularly useful for creating data banks that will ultimately be installed on a
shared network drive.

File Remove Write-Protection [CTRL+W]
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Removes write-protection from a data bank.

File Add [CTRL+A]

Reads data stored in a file and adds the data to the data bank with the same filename as the input file.  The
input file can be organized in Dbank’s FREE, SERIES, or MATRIX format; or the data can be read
directly from an EXCEL spreadsheet.

File Add From DOS-DBANK [CTRL+N]

Converts a DOS-Dbank file to WINDOWS-Dbank format. The data will be added to the data bank with
the same filename as the DOS-Dbank file.  Dbank will prompt you for the name of the DOS data bank to
convert.  This command is provided for downward compatibility with earlier versions of Dbank.  Users
unfamiliar with the character-based version of Dbank can ignore this command.

File Shell [CTRL+S]

Invokes a character-mode DOS session.  Type EXIT to return to Dbank.

File Calculator [CTRL+T]

Calls up Windows’ CALCULATOR program.  CALC.EXE must be on the active path for this command
to work.

File Excel [CTRL+M]

Calls up Microsoft’s Excel spreadsheet.  Excel must be installed or EXCEL.EXE must be on the active
path for this command to work.

File Print Form [CTRL+F]

Dumps Dbank’s startup form to the active printer.

File Exit [CTRL+X]

Closes all disk files and ends the Dbank session.
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Group Menu

The group menu (shown above) allows you to manipulate entire groups of series (and the series in the sub-
groups).  You can activate the group menu by typing Alt+G or by clicking on the GROUP menu using the
mouse.

Dbank data banks possess a hierachical tree structure similiar to the PC-DOS file system.  Double-clicking
on a group fills the group list box with the names of the groups that belong to that group (and so on to any
number of levels).  Double-clicking on the parent group moves you up one level in the tree.  Double-
clicking on the main group moves you to the main or root group in the data bank.

Note that the group list box allows you to select more than one group.  To select a single group, click on
the group using the mouse. Shift+click or Shift+arrow key extends the selection from the previously
selected item to the current item. Ctrl+click selects or de-selects an item in the list.

There are short-cut keys for each command in the Group Menu.  These keys are active whenever the group
list box has the focus.  You can give the group list box the focus by clicking on the group list box with the
mouse.

Group Browse [B,b]

Loads Dbank’s BROWSE form, which provides a tabular representation of series’ index records.  The
BROWSE form allows you to COPY, DELETE, TAG, UNTAG, RENAME, EDIT, PLOT, and VIEW
series.
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Group Copy [C,c]

Copies all the series in the selected groups (and their associated sub-groups) to a different group or data
bank.  The destination group or data bank need not exist. If you wish to copy the series to another data
bank, use the syntax FileName[GroupName] when you are prompted for the destination of the series.  Thus
to copy all the series in the group [FIRST] to another data bank, say EXTRACT, in a group called
[PAPER.WHITE], you type EXTRACT[PAPER.WHITE] when you are prompted for the destination of
the series.  To copy to another group within the same data bank,  specify just the destination group—e.g.,
[PAPER.WHITE]

Group Delete [D,d]

Deletes the selected groups.  The groups must be empty (i.e., not have any series nor any sub-groups).

Group Label [A,a]

Allows you to attach a label/description ( < 80 characters) to a group.  You can edit existing group labels
using this command.

Group Make [K,k]

Creates a new group in the current data bank that belongs to the current group.

Group Memo [F2]

Allows you to attach a lengthy description ( < 32K ) to a group.  You can edit existing group memos using
this command.

Group Move [V,v]

Moves the series in the selected groups (and their associated sub-groups) to another group.  The destination
group/data bank need not exist.

Group Query

Finds all the series in the selected groups (and their sub-groups) that satisfy your query.  The matched
series are displayed in Dbank’s BROWSE form, which allows you to COPY, DELETE, TAG, UNTAG,
RENAME, EDIT, PLOT, and VIEW the series.  You can construct queries on the series titles ([Title]), the
series names ([Name]), the frequency of the series ([Frequency]), and the "long-name" of the series ([Long
Name]).
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Group Rename [R,r]

Renames the selected groups (one at a time).

Group Sort [F3]

Sorts the entries in the group list box by name.

Group Tag [T,t]

Tags all the series in the selected groups (and their sub groups).  The tagged series are displayed in the
tagged list box. They can then be manipulated as a unit using the commands in the Tagged Menu.

Mouse short-cut:  select the groups you wish to tag and then click on the RIGHT mouse button.

Group View [W,w]

Loads Dbank’s VIEW form with all the series in the selected groups (and their sub-groups).  The VIEW
form shows you the data saved in a series.

Group UnTag [U,u]

Untags all the series in the selected groups (and their sub-groups).

Group Xdelete [X,x]

Deletes all the series in the selected groups and their sub-groups, and (optionally) the empty groups
themselves.

Group Peek

Loads the PEEK form with all the series in the selected groups (and their sub-groups). The PEEK form
allows you to inspect a subset of the data stored in the series.  It is particularly useful for inspecting series
which have too many observations for Dbank's VIEW form.

Group Print [P,p]

Prints all the series in the selected groups and their sub-groups (including the data).
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Group Print Index [I,i]

Prints the index record of all the series in the selected groups and their sub-groups.

Group Mosaic Time Plot [L,l]

Provides a mosaic time plot of the all the series in the selected groups and their sub groups.

Group Summary Statistics [M,m]

Computes various summary statistics (e.g., mean, variance) for all the series in the selected groups and
their sub-groups.



01/31/94 06:46 PM

26

Series Menu

The Series Menu (shown above) allows you to add series to the current data bank and execute various
commands on objects in the series list box.  You can access these commands by clicking on the series menu
with the mouse or by typing ALT+S.

All the series in the current group are shown in the series list box.  The series list box allows you to make
single or multiple selections.  To select a single item in the series list box, click on the item using the
mouse.  Shift+click or Shift+arrow key extends the selection from the previously selected item to the
current item. Ctrl+click selects or de-selects an item in the list.

Each command in the Series Menu has a short-cut key that is active whenever the series list box has the
focus. You can give the series list box the focus by clicking on the series list box with the mouse.

Series Add [A,a]

Reads data into Dbank.  The data can be organized in any one of Dbank’s FREE, SERIES or MATRIX
format; or it can be read directly from an EXCEL spreadsheet.  The data will be added to the current data
bank.  See “Reading your data into Dbank” for further details.
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Series Browse [B,b]

Loads Dbank’s BROWSE form, which provides a tabular representation of the index records of the
selected series.  The BROWSE form also allows you to COPY, DELETE, TAG, UNTAG, RENAME,
EDIT, PLOT, and VIEW series.

Series Copy [C,c]

Copies the selected series to another series, group or data bank.  To copy a series to another data bank, use
the syntax Drive:\Path\FileName[GroupName]SeriesName.  For example, to copy the series BPASPV in
the group [FIRST] to another data bank, say EXTRACT, in a group called [PAPER.WHITE.A4], you
type EXTRACT[PAPER.WHITE.A4]BPASPV when the Series Copy command prompts for the
destination of the series.  To copy to another group within the same data bank, you specify just the
destination group— e.g., [PAPER.WHITE.A4].

Series Convert

Converts a series to a lower frequency (e.g., from quarterly to annual, or from null frequency to quarterly).
Five conversion methods are supported in Dbank: SUM, FIRST, AVERAGE, LAST and MID-POINT.

Series Delete [D,d]

Deletes the selected series.

Series Edit [E,e]

Invokes the EDIT form, which allows you to edit the current series’ index record and its data.

Series Input [N,n]

Invokes the INPUT form, which allows you to manually input data into Dbank.

Series Link

A link variable is a pointer to an existing set of observations in a data bank.  It is essentially another name
for the same observations in the data bank.  However, it is best understood as a pointer to the data of the

series, not to the name of an existing series.  This feature of Dbank enables you to maintain a single copy
of the data in the data bank, but with many pointers to the same data.  Thus, changing the data (via an edit
operation, for example) changes the data for all the series that point to that data.  Note that a link variable
may span across groups, but it cannot refer to a series in a different data bank.  Dbank automatically alters
the pointers if you rename/move the series being pointed to.
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Deleting a link variable does NOT delete the original series, and deleting a linked series does NOT delete
the link variable(s).  However, if you squeeze the data bank, any link variables that point to a previously
deleted series will NOT appear in the squeezed version of the data bank.

“Link Create” creates a link variable; “Link Show” shows all the link variables that exist for a particular
variable; and “Link Convert to Ordinary Series” converts a link variable to a normal variable.

Series Make [K,k]

Creates a new series from existing series in the data bank.  Series Make accepts an algebraic expression
involving series or numbers and computes the result.  Make recognizes the following operators:

 ^ (power), - (unary negation), * (multiplication), / (division), \ (integer division), % (Modulo arithmetic),
%# (Modulo arithmetic without integer truncation), + (addition), - (subtraction),  = (equal to), <>
(inequality), < (less than), > (greater than), <= (less than or equal to), >= (greater than or equal to), !
(Bitwise unary NOT), & (Bitwise AND), | (Bitwise OR), ^| (Bitwise XOR), == (Bitwise EQV), =>
(Bitwise IMP)

and the following functions:

Abs (Absolute) Log (log to base e), Log10 (log to base 10), Sqr, Fix (towards 0), Int (towards left), Ceil
(ceiling), Sgn, Rnd (stochastic random number), Rndfix (deterministic random number), Deg (Degree), Rad
(Radian), Exp (exponential), ExpSmooth (exponential smoother), Smooth (Friedman's super-smoother),
Mean, Median, Sd (standard deviation), Demean (removes the mean), Var (Variance), Acf (correlogram),
Pdf (probability density function), Lead (lead a series one period), Lag (lag a series one period), Ma
(centered moving average), Diff (difference), MDiff (multiple difference), SigDigits (significant digits of a
number), Round, Reverse (reverse the vector), Csum (cumulative sum), Cprod (cumulative product), Sort,
Permute (shuffle the vector), Index, Rank, Period (periodicity indicator), Ismiss (flags missing values),
Pack (remove missing values), Trim (trim a vector), Select (randomly select a subset of the vector),
SelectIndex (generates a vector of selection indices),  Sin, Cos, Tan, Sec, CoSec, CoTan, Asin, Acos, Atan,
Asec, Acosec, Acotan, Sinh, Cosh, Tanh, Sech, Cosech, Cotanh, Asinh, Acosh, Atanh, Asech, Acosech,
and Acotanh.

With the exception of ACF, LEAD, LAG, ROUND, DIFF, MDIFF, MA, SIGDIGITS, SELECT,
SELECTINDEX, TRIM, and the EXPSMOOTH functions, all of the listed functions accept a single
argument.  The argument may be a single series or the result of any algebraic operation(s) on any series.

The syntax for the ACF, LEAD, LAG, ROUND, DIFF, MDIFF, MA, SIGDIGITS, SELECT,
SELECTINDEX, TRIM, and EXPSMOOTH functions is

fn(arg1, arg2, arg3, arg4...);

that is, they accept more than one argument.
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In the case of LEAD/LAG, arg2 is the number of periods to LEAD/LAG the series (i.e., arg1). DIFF(x,k)
= x(t)-x(t-k), and MDIFF(x,k) applies DIFF(x,1) to x(t) k-1  times.  MA(x,k) computes a kth period
(centered) moving average of x.  In ROUND, arg2 is the number of decimals to round arg1 to. If k is
negative, ROUND rounds arg1 to the (-k+1)st digit to the left of the decimal point.  For the EXPSMOOTH
function, arg2 can be any real number between 0 and 1 (inclusive).  For ACF, arg2 is the maximum auto-
correlation lag.  SIGDIGITS(x,k) returns the number of required (k) significant digits of x.  If k is negative,
SIGDIGITS(x,k) preserves any integer part of x.  For TRIM, arg2 is the number of data points to remove
from the beginning of the vector, and arg3 is the number of data points to delete from the end of the vector.

For SELECT(x, arg2), arg2 is the number of elements of  x to randomly select.  And for
SELECTINDEX(x, arg2), arg2 is the number of indices (pointing to elements of x) to select.

Arg2 can be omitted when using some of these functions.  Arg2 defaults to one (1) in the
ACF/LEAD/LAG/DIFF/MDIFF functions and to zero (0) in ROUND.

Functions can be nested to any depth (memory permitting).  For example, if x and y are series in the current
data bank, then the following algebraic expression is allowed:

lead(exp(lag(abs(log(x+y)^4),5)),10)

Note that the result of the operation will be a series of the same frequency as series  x  and  y.  The length
(or sample period) of the new series will be the maximum sample period over which both x and y exist.

The symbol PI# has been defined to π  (the mathematical constant) in Series Make.

Make accepts fully qualified series names (i.e., data_bank[group]ser_name).  However, if fully qualified
names appear on the right-hand side of the equation, they MUST be enclosed in double quotes (" ").   Note
that the data bank on the left-hand side of the equation need not exist.

Lastly, Make accepts more than one algebraic expression at a time.  Separate each expression using a semi-
colon (;).  Thus,  typing

a1 = ln(bpaspv) ; a2 = exp(bpaspv)

in Make’s input box creates two series, a1 and a2.
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Operator precedence:  arithmetic operators are evaluated first, comparison operators are evaluated next,
and logical operators are evaluated last.  Within individual categories, operators are evaluated in the
following order of precedence:

Arithmetic Comparison Logical

Power (^) Equality (=) Not (!)

Negation (-) Inequality (<>) And (&)

Multiplication and division (*, /) Less than (<) Or (|)

Integer division (\) Greater than (>) Xor (^|)

Modulo arithmetic (%, %#) Less than or Equal to (<=) Eqv (==)

Addition and subtraction (+, -) Greater than or Equal to (>=) Imp (=>)

All comparison operators have equal precedence; thus they are evaluated in the left-to-right order in which
they appear in the expression.

When multiplication and division occur together in an expression, each operation is evaluated as it occurs
from left to right.  Likewise, when addition and subtraction occur together in an expression, each operation
is evaluated in order of appearance from left to right.

You can override the operator precedence table by using parentheses.

Note: -1 is true in Dbank; 0 represents false

Series Memo [F4]

Allows you to attach a lengthy description ( < 32K characters) to a series.  You can edit existing series
memos using this command.

Series Move [V,v]

Moves the selected series to another group.  The destination group need not exist.  You cannot move series
to another data bank.

Series Rename [R,r]

Renames the selected series in the series list box (one at a time).

Series Sort [F5]
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Sorts the series in the series list box by name.

Series Tag [T,t]

Tags the selected series, and places their fully-qualified name in the Tagged list box.  To flag their tagged
status,  Dbank appends a superscript “1” to the tagged series in the series list box.  You may tag a series
more than once.  When you do so, the tagged series is moved to the end of the tagged list box. This feature
is provided because a number of Dbank commands attach special significance to the last series in the
tagged list box, e.g., take it as the Y (dependent) variable.

Mouse Shortcut (Series Tag): double-click on series you wish to tag or select the series you wish to tag
and then click on the RIGHT mouse button.

Series UnTag [U,u]

Untags the selected series, removing their entry from the tagged list box.

Series View [W,w]

Invokes the View form, which displays the data in the selected series.

Series Peek

Loads the PEEK form with all the selected series. The PEEK form allows you to inspect a subset of the
data stored in the series.  It is particularly useful for inspecting series which have too many observations
for Dbank's VIEW form.

Series Print [P,p]

Prints the selected series (and its data).

Series Print Index [I,i]

Prints the index record of the selected series.

Series Probability Density Estimate [Y,y]
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Estimates the probability density of a single series and plots the result.

Series Summary Statistics [M,m]

Computes various summary statistics (e.g., mean, variance) for the selected series.

Series Scatter Plot [O,o]

Provides an XY plot of the LAST two selected series in the series list box.  Y is the last series you select.

Series Time Plot [L,l]

Plots the selected series against time.
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Tagged Menu

The Tagged Menu (shown above) allows you to execute commands on the series in the tagged list box.
You can access the menu by clicking on the tagged menu with the mouse or by typing Alt+T. Most of the
tag commands have a short-cut key.  The short-cut key is operational whenever the tagged list box has the
focus.  You can give the tagged list box the focus by clicking on the tagged list box with the mouse.

The tagged list box allows you to make single or multiple selection.  To select a single series in the tagged
list box, click on the series name using the mouse.  Shift+click or Shift+arrow key extends the selection
from the previously selected item to the current item.  Ctrl+click selects or de-selects an item in the list.

By default, the Tagged Menu commands operate only on the series you have selected in the tagged list

box.  However, if you do not select (i.e., highlight) any series, the Tagged Menu commands will

operate on ALL of the series in the tagged list box.

Tagged Browse [B,b]

This command displays Dbank’s BROWSE form using the series in the tagged list box. Dbank’s
BROWSE form allows you to perform various data bank operations on the series, including COPY,
DELETE, TAG, UNTAG, RENAME, EDIT, PLOT, and VIEW.
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Tagged Copy [C,c]

This command copies the tagged series to another data bank/group.  To copy to another data bank, use the
syntax Drive:\Path\FileName[GroupName].  Thus to copy all the series in the tagged list box to another
data bank, say EXTRACT, in a group called [PAPER], you type EXTRACT[PAPER] when you are
prompted for the destination of the series.  To copy to another group within the same data bank, specify
just the destination group—e.g., [PAPER].

Tagged Delete [D,d]

Deletes the series in the tagged list box.

Tagged Edit [E,e]

Invokes the EDIT form, which allows you to edit the tagged series (one at a time).

Tagged Move [V,v]

Moves the tagged series to another group.  The destination group need not exist.

Tagged Rename [R,r]

Renames (one at a time) the series in the tagged list box.

Tagged Sort [F6]

Sorts the series in the tagged list box by name.

Tagged UnTag [U,u]

Untags the series in the tagged list box.   Mouse Short Cut:  click the RIGHT mouse button.

Tagged View [W,w]

Invokes the View form, which displays the data in the tagged series.
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Tagged Peek

Loads the PEEK form with all the series in the tagged list box. The PEEK form allows you to inspect a
subset of the data stored in the series.  It is particularly useful for inspecting series which have too many
observations for Dbank's VIEW form.

Tagged Print [P,p]

Prints all the series (and their data) in the tagged list box.

Tagged Print Index [I,i]

Prints the index record of all the series in the tagged list box.

Tagged ACE [A,a]

ACE was published by Leo Breiman and Jerome Friedman on pp. 580-619 of the September, 1985 issue
(Volume 80) of the Journal of the American Statistical Association: Estimating Optimal Transformations

for Multiple Regression and Correlation (with discussion).  Tagged ACE implements this procedure for
all the series in the tagged list box.  Invoke ACE and select the Help menu for further information on ACE.

Tagged Export [X,x]

Invokes the EXPORT form, which allows you to copy the tagged series to an ASCII file.  The file can be
structured in any one of the supported output formats (i.e., AREMOS, BMDP, FREE, TSP, MICRO TSP,
GAUSS,  LIMDEP,  MATRIX,  MINITAB,  SAS,  SERIES, SPSS,  SST,  RATS,  LOTUS,  EXCEL
and  QUATTRO).

You indicate the output format using the Format menu of the EXPORT form; the sample period using the
BOUNDS button of the EXPORT form, and the name of the output file using the File OPEN menu of the
EXPORT form.

Tagged Mosaic Plots

Provides various mosaic plots of the selected series in the tagged list box.  Mosaic Time Plot plots the
tagged series against time; Mosaic (X,Y) Pairs Plot produces a scatter plot of all the (X,Y) pairs in the
tagged list box (i.e., 1 vs. 2, 3 vs. 4, 5 vs. 6, etc.); and the Mosaic Single Y vs. Xs Plot produces a scatter
plot of the last series in the tagged list box against each of the remaining series in the tagged list box.
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Tagged Scatter Plot [O,o]

Provides an XY plot of the LAST two selected series in the tagged list box.  Y is the last series that you
have selected.

Tagged OLS-IV-2SLS Regression [2]

Invokes Dbank’s regression module using the selected variables in the tagged list box.  Dbank supports
Ordinary Least Squares (OLS) and Instrumental Variable Estimation (2SLS).

Tagged Summary Statistics [M,m]

Computes various summary statistics (e.g., mean, variance) for the selected series in the tagged list box.

Tagged Time Plot [L,l]

Produces a time plot of all the series in the tagged list box.
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Exporting your Data to Other Programs

An important feature of Dbank is its ability to transfer your data to files that can be processed immediately
by other programs.  Dbank’s EXPORT command implements this feature.

You must select (i.e., tag) the series you wish to copy before invoking the EXPORT form.  You can tag
series using the TAG command in the GROUP and SERIES menus.  You can also tag series using the
mouse; simply double-click on a group or a series name.

The Tagged EXPORT command loads Dbank’s EXPORT form which allows you to specify:

(a) the sample period for the copy.  The sample period determines which part of 
the tagged series to copy;

(b) the output format (i.e., the structure of the output file);

(c) the conversion method Dbank should use when it needs to convert a series to a 
lower frequency (e.g., from quarterly to annual); and,

(d) the name of the output file (i.e., the destination of the copied series).

Dbank will not allow you to export any series until all of the following parameters have been set:

(a) the sample period;

(b) the output format; and

(c) the name of the output file.

If you find the above confusing (many do),  try tagging a few series and then calling up the EXPORT form.
It is programmed to step you through the EXPORT process.

The following pages provide a detailed explanation of the EXPORT form.
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Export File Menu

The FILE menu of the EXPORT form is shown above.  You invoke this menu by clicking on the File Menu
with your mouse, or by typing Alt+F.

Use the OPEN command to specify the name of the output file for the tagged series.  You need not specify
a file extension.  Dbank will append an extension to the filename that depends on the current output format
you have selected.  Note that the OPEN command is disabled until you chose an output format.

The PEEK command allows you to view the first 15 kilobytes of the output file (after it has been created).

The CLOSE command closes the output file.

The MISSING VALUE command is used to override the “missing value” code on output.   This is the
value that Dbank will place in the output file to indicate that an observation is missing.

If you do not use the MISSING VALUE command, the default value depends on the current output format.
By default,  Dbank uses a period (i.e., “.”) provided the statistical package supports it.  Otherwise,
Dbank’s missing value code is ‘NaN’ (short for ‘Not a Number’).  You can easily override this default
using the MISSING VALUE command.

The VERBOSE command allows you to monitor the progress of the copy command.  When VERBOSE is
enabled, Dbank will display the name of the series it is currently processing.

The SHELL command creates a character mode DOS session.  Type EXIT to return to Dbank.

The EXIT command closes the EXPORT form.
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Export Tagged Menu

The “Tagged” menu allows you to add and delete series from the tagged list box of the Export form.  Use
the “Add Variables” menu item to add series to the list box and the “Remove Variables” menu item to
remove series from the tagged list box.  The View menu item loads Dbank’s View form which allows you
to inspect the data.
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Export Convert Menu

The CONVERT menu controls the manner in which Dbank converts a time series to a lower frequency.  By
default, Dbank converts time series to a lower frequency using the conversion method indicated on the
series’ index record.

The OFF command suppresses automatic conversion (the default).  In OFF mode, Dbank will attempt to
copy the series to the output file without conversion.   Of course, sometimes this is not possible—for
example, when you have selected an output format (e.g., GAUSS, LOTUS, QUATTRO, or EXCEL)
which produces a rectangular dataset (i.e., one in which all the series have the same number of
observations).

The AUTOMATIC command allows you to override the default conversion method specified on the series’
index record.  You may choose any one of the five conversion methods supported in Dbank:  (a) FIRST
(i.e., use the first data point of the period);  (b) LAST (i.e., use the last data point of the period); (c) SUM
(i.e., use the sum of the data points in the period); (d) AVERAGE (i.e., use the average of the data points in
the period); and (e) MID-POINT (i.e., use the middle observation).

The PROMPT command instructs Dbank to prompt for a conversion method before copying the series to
the output file.  The PROMPT command supports two modes:

(a) FOR ALL SERIES:  Dbank will prompt for a conversion method for each series to be copied—
even if an internal conversion method has been specified on the index record; and,

(b) ONLY IF NECESSARY:  In this case,  Dbank prompts for a conversion method only when an
internal conversion method is not available for the series being processed.
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Export Format Menu

The FORMAT menu controls the output format for the tagged series.  Select the format you want your
data to be copied in.

If the output format is set to “DDE” to Excel, Dbank attempts a “dynamic data exchange” to an Excel
spreadsheet.  You need a copy of  Microsoft Excel for this feature to work.
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Export Filter Menu

Dbank can filter (or mask) a series according to the value of another series (called the FILTER). This
feature is very useful for cross-sectional data, where it is often necessary to extract a portion of a series
depending on the value of another series.   Please note that you need to set the global frequency before you
can use the Filter command.  Click on the BOUNDS button of the EXPORT form to set the global
frequency.

The Filter command operates in exclusive or inclusive mode.  When the filter mode is inclusive, Dbank
copies an observation of a series only if the corresponding observation in the filter variable is equal to a
particular value (e.g. ‘1’).  However, when the filter mode is exclusive,  Dbank copies an observation of a
series only if the corresponding observation in the filter variable is NOT equal to the filter value.

The “Specify Filter Variable...” command is used to specify the name of the filter variable.  Though the
filter variable need not reside in the same data bank, it must have the same frequency as the current global
frequency.

The “On/Off” command allows you to switch off the masking function after you have selected a filter.

The “Value...” command allows you to specify the filter value.  For example, if the filter value is 5, and the
filter mode is inclusive, Dbank will copy an observation in the tagged series only if the corresponding
observation in the filter variable is  5.  Note that the same variable can store more than one filter value.
Thus the same filter variable can extract different observations depending on the filter value.
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BOUNDS Form

Dbank’s “BOUNDS” form is shown above.  You use it to set the global frequency and the sample period
for the EXPORT form.

Unless Dbank’s export conversion switch is turned off,  you must choose a global frequency and set the
sample period (or bounds) before you can export data to another program.  The sample period defines the
starting and ending date for the series to be exported; the global frequency is the target frequency.  For
example, if you select ‘quarterly’ for the global frequency but some of the series in the tagged list box have
monthly frequency, Dbank will attempt to convert the monthly series to quarterly before they are exported
to the output file.

The FREQUENCY menu of the BOUNDS form is used to set the global frequency [i.e.,  ANNUAL,
HALF-YEARLY, QUARTERLY, MONTHLY, WEEKLY, DAILY(5), DAILY(6), DAILY(7), or
NONE].  Once you select a global frequency, Dbank will display the maximum sample period that exists in
the tagged series. Press OK to accept the maximum sample period and return to the EXPORT form.
Otherwise, adjust the sample period to your own needs and then press OK.  Please note that Dbank is
unable to determine the maximum sample period when none of the tagged series has a frequency equal to
the current global frequency.

Dbank date formats depend on the global frequency.  For weekly and daily data, you need to specify the
first day, month and year of the sample, and the last day, month and year of the sample.  For half-yearly,
quarterly, and monthly data you need to specify the first year and first period, and the last year and period
(format: yyyy:pp, e.g. 1981:1).  For annual data, specify the first and last year.

For data stored with no frequency (such as cross-sectional data), the first observation would have a start
date of ‘1’.  The last observation would have an end date of  ‘N’, where N is the number of observations in
the series.

Press CHECK button to check your bounds entry is valid; use the CHECK button before pressing the OK
button.
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The OK button instructs Dbank to process the BOUNDS command.

The CANCEL button removes the BOUNDS form without changing the current bounds.

IMPORTANT: When all tagged series in the tagged list box have the same frequency, Dbank will
automatically set the global frequency to the frequency of the tagged series before it brings up the
BOUNDS form.  Therefore, in this case, when you invoke the BOUNDS form it will display the maximum
sample period that exists in the tagged series.  Press OK to select the maximum sample period; otherwise
adjust the sample period to you own requirements and then press OK.
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Reading your data into DBANK

Dbank can process three types of ASCII data files:  FREE format,  SERIES format and MATRIX format.
The default input format is FREE.  If you have a copy of Microsoft’s EXCEL spreadsheet,  Dbank can
also read the data stored in an EXCEL spreadsheet using Window’s Dynamic Data Exchange facility.

The SETUP program installs examples of each of the ASCII files on your hard disk (they are stored in the
same directory that you installed Dbank).  The file called EXAMPLE.FRE is organized in Dbank’s FREE
format. Two other files, EXAMPLE.SER and EXAMPLE.MAT, are examples of Dbank’s SERIES and
MATRIX input formats (respectively).  You can use these files to learn how to create data banks and
manage data.

Input files are processed by the “Add Data...” command which appears in both the File and Series menus of
Dbank’s startup (or main) form.  If you invoke the “Add Data...”  command from the Series menu, Dbank
will add the data stored in the ASCII file to the data bank you have opened.  However, if you invoke the
command from the File menu, Dbank adds the data to a data bank with the same filename as the ASCII
input file (Dbank will create the data bank if necessary).

1. FREE format (default extension: .FRE)

To read your data into Dbank using Dbank’s FREE format you need to create an ASCII file that contains,
for each series,  the following information:

 1. [group name{.sub_group{.sub_group...{,Group Label}}}]Name Obs Freq  F_year  F_period  F_day  Con_Code Precision Long_Name

 2. Series Title—this is where you put the title of the series

 3. Data Values

where:

1. ‘[group_name{.sub_group{.sub_group...{,Group Label}}}]Name’ is the identifier of the series.
For example, [CITY.NY]BPB is a legal Dbank name.  BPB is the name of the series and it belongs to the
sub-group NY in the group called CITY.  Note that group, sub-group, and series names cannot be longer
than 8 characters.  Also, fully qualified group names must be delimited by left and right brackets (i.e., [ ])
Lastly, ‘{,Group Label}’ refers to an optional ( < 80 character) descriptor for the group.  The label is
ignored if the group already exists.

A group (or sub-group) does not need to exist to add data to a data bank; Dbank will automatically create
the group during the reading process.

2. ‘Obs’ is the number of observations in the series
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3. ‘Freq’ is a one-character code representing the frequency or periodicity of the series.  Data with
ANNUAL(A), HALF-YEARLY(H), QUARTERLY(Q), MONTHLY(M), WEEKLY(W), DAILY - 7-day
week (D), DAILY - 6-day week (S), DAILY - 5-day week (F),  or a NULL (N) frequency can be saved in a
Dbank data bank.  The  NULL  frequency is most appropriate for cross-sectional data.

4. ‘F_year’ is the first year of the data.   Use 1 for data with a NULL frequency.

‘F_period’ is the first period of the data.  For HALF-YEARLY data, F-period can be set to 1 or 2;
for QUARTERLY use 1, 2, 3 or 4; for MONTHLY, WEEKLY, and DAILY data use any integer in the
range from 1 and 12 (inclusive), and for data with NULL frequency, use 0.

‘F_day’ is the first day of the data (use the appropriate day of the month for WEEKLY and
DAILY data; 0 for other frequencies).

5. ‘Con-code’ is the conversion method Dbank should apply to the series when converting the data to
a lower frequency (e.g., from WEEKLY to ANNUAL).  Dbank currently supports 5 conversion methods:
(a) AVERAGE; (b) SUM; (c) FIRST; (d) LAST; and (e) MID-POINT.   You may also specify  NONE  to
prevent conversion.  Only the first letter of the conversion method need be specified in the input file.

6 ‘Precision’ is the precision with which Dbank will save the data in the data bank.   Dbank can save
data in SINGLE or DOUBLE precision.  Single precision requires four (4) bytes per number; double
precision requires eight (8).  Use single precision to minimize the size of your data bank.  Only the first
letter of the precision need be specified.

7. ‘Data’ is the actual data of the series. The amount of data Dbank expects to read is determined by
the number of observations specified in step 2 above.  Use as many records (or lines) as you need to list all
the data.  The input format is free.

8. ‘Long_Name’ (optional) is the long-name of the series (up to 50 characters).  Use this argument to
provide a more descriptive name for a series.  Note that Dbank does not allow you to refer to a series
according to its long-name.

Note that the input file can contain any number of series (of any frequency and precision).

Dbank supports missing values on input.  The missing value code is a period (i.e., ‘.’).  You can change the
missing-value code to a numeric value by including the following command in the input file:

MVAL  ‘your own missing value (e.g., -999).’

For example,

MVAL  -999
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sets the missing value to -999.

Dbank will not use -999 when it actually saves the data in the file.  Dbank stores missing values using a
special missing value code.  On output, missing values are indicated by  ‘NaN’  (i.e., Not a Number) or a
period (‘.’), provided the destination program supports it.

The following lines show the correct input format for a cross-sectional (Freq = N) series with 10
observations:

[DEBT,Stock Data]DEBTLXL   10     N     1    0    0  N  S  DEBT_STOCK_RATIO

debt-stock to exports ratio

0.871850014 . 1.08260000 1.32647002 0.68683999

0.91070997 1.06666005 1.31024003 1.91513002 1.51312006

Dbank will store the series  DEBTLXL  in the group  DEBT  (with a label of ‘Stock Data’) using SINGLE
precision. The series title will be ‘debt-stock to exports ratio’.  The series long-name is
DEBT_STOCK_RATIO.  As DEBTLXL is cross-sectional data, its frequency is set to N (for ‘NULL’),
the first period is ‘1’, and the conversion method is set to NONE.  Note that the second observation is
missing in the above example.

This is the correct format for a quarterly series with 58 observations:

[FIRST.US.Q,Balance of Payments Data, USA]BPASPV      58  Q     1976    1  0  A  D

BAL OF P'MENT:U.S.PRIVATE ASSETS_ NET(MIL$_S.A.)

 -10838.00 -9207.00 -8782.00 -15671.00

  284.00 -11273.00 -5408.00 -14320.00

-14397.00 -4597.00 -8424.00 -29784.00

-3535.00 -15129.00 -28069.00 -12718.00

-8240.00 -24236.00 -17031.00 -23295.00

-17429.00 -19886.00 -15953.00 -47410.00

-31658.00 -38825.00 -22784.00 -20129.00

-23765.00 -297.00 -9278.00 -16562.00

-1037.00 -20168.00 15974.00 -17221.00

-3119.00 838.00 -3357.00 -15408.00

-13137.00 -22608.00 -22851.00 -31724.00

11459.00 -25815.00 -25581.00 -33156.00

4661.00 -19048.00 -36960.00 -31885.00

-29821.00 11017.00 -38654.00 -45496.00

36713.00 -26190.00
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Dbank will save  BPASPV  in the sub-group called  Q (with label ‘Balance of Payments Data, USA’)
which belongs to the sub-group US with parent FIRST.  The series will be saved in double precision.  The
series starts in the first quarter of  1976.  Dbank will convert the series to a lower frequency using the
average of the appropriate quarters.  The series will not have a long-name.

If the input file contains series that already exist in the destination data bank,  Dbank will, by default,
overwrite the contents of the series with the data in your input file.  In effect, the old series is deleted before
the new series is copied to the data bank.  If you wish to simply update the existing data in a series without
destroying the non-overlapping parts of the data (all the new data will be accepted, but all non-intersecting
parts of the old data will be retained), you must switch to Dbank's update mode by inserting the command

UPDATE ON

in the input file.  You can switch off update mode with the command

UPDATE OFF

The update command is allowed only in FREE format input files.

2. SERIES format (default extension:  .SER)

Series format is similar to FREE format but much simpler.   You do not need to specify anything except the
name of the series.  The name of the series may optionally be preceded by a group specification.

The following lines show the correct format for the BPASPV series using the SERIES format:

[FIRST]BPASPV

-10838.00  -9207.00 -8782.00 -15671.00

284.00 -11273.00 -5408.00 -14320.00

-14397.00 -4597.00 -8424.00 -29784.00

-3535.00 -15129.00 -28069.00 -12718.00

-8240.00 -24236.00 -17031.00 -23295.00

-17429.00 -19886.00 -15953.00 -47410.00

-31658.00 -38825.00 -22784.00 -20129.00

-23765.00 -297.00 -9278.00 -16562.00

-1037.00 -20168.00 15974.00 -17221.00

-3119.00 838.00 -3357.00 -15408.00

-13137.00 -22608.00 -22851.00 -31724.00

11459.00 -25815.00 -25581.00 -33156.00



01/31/94 06:46 PM

49

4661.00 -19048.00 -36960.00 -31885.00

-29821.00 11017.00 -38654.00 -45496.00

36713.00 -26190.00

Dbank will determine the number of observations in BPASPV.  It will save BPASPV in a group called
[FIRST] (which need not exist in the current data bank) using double precision storage and the NULL
frequency.

You may include as many series as you wish in a single  .SER  file.

3. Matrix format (default extension: .MAT)

Matrix format is the simplest format supported by Dbank.  To use this format, your data must be organized
as a matrix in the input file.  Each column of the matrix is treated as a separate series, while each row is
regarded as a separate observation on each of the series.  If there are no labels on the first line of the input
file, the first column will be named C1.  The second column will be named C2, and so on.  You can
override this naming convention by providing names for each column on the FIRST line of the input file.

Dbank will save the data in a group with the same name as the input file.  Thus, if EXAMPLE.MAT
contains four columns of data, Dbank will automatically create (assuming it does not exist already) a group
called [EXAMPLE] with four series named  C1, C2, C3, and C4.  By default, the series are saved in the
current data bank using double precision storage and the NULL frequency.

The following is an example of a MATRIX input file, say FIRST.MAT.   Dbank will create four series
(each with six observations):

-9345.00 -9207.00 -8782.00 -15671.00

 284.00 -11273.00 -5408.00 -14320.00

-14397.00 -4597.00 -8424.00 29784.00

-3535.00 -15129.00 -28069.00 -12718.00

-45256.00 -82949.00 -47575.00 -24242.00

-87484.00 -53245.00 -23455.00 -23423.00

As there are no labels in the input file, Dbank will name the first column ‘C1’.  The second column will be
called ‘C2’, and so on.  Each column will be saved in the current data bank using the NULL frequency and
double precision storage.  The columns will be saved in the group called [FIRST] (i.e., the name of the
input file).
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4. ROUNDING

Dbank is able to round the input numbers to a given number of decimal places.  Insert the following line in
your input file:

ROUND n

where  n  is the number of decimal places to round the input number.  If  n  is negative, ROUND rounds the
input number to the (-n+1)st digit to the left of the decimal point.  You can insert more than one ROUND
statement in the input file. Once activated, rounding can be switched off by the command

ROUND OFF
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Installing Dbank Files on a Network

A Dbank data bank can be installed on a shared network drive (i.e., a drive that can be accessed by more
than one user at the same time); however, it must be converted to “read-only” before it is copied to the
network drive.

IMPORTANT: This version of Dbank does not support write-enabled data banks in a multi-user

network environment.  Please do not install write-enabled data banks to a shared network drive.

Read-only data banks are created using Dbank's "Make Read-Only" command (Alt+F+Y).  Every read-
only data bank has two (2) files associated with it:

<databank_name>.MDB, and

<databank_name>.FDB

where "<databank_name>" should be replaced with the actual name of the data bank.  The ".MDB" file
contains the index records of the series, while the ".FDB" file contains the data saved in binary format.

Copy the two (2) files to the network drive.  After you have done so, make sure you set the file attribute of
<databank_name>.mdb and <databank_name>.fdb to "+r " (i.e., read-only) using the DOS ATTRIB
command.  This will permit multi-user access to the data bank.

The four *.bat files distributed with Dbank give an example of the installation of Dbank on a network.

Dbank and all of its data banks can be made to run directly from a CD-ROM with no prior setup except for
the pre-loading of SHARE.EXE.  Thus Dbank provides an efficient method of distributing large amounts
of data.


